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Chapter 1. Overview of the agent

The IBM Tivoli Composite Application Manager Agent for PeopleSoft Enterprise Process Scheduler
(product code P9) provides you with the capability to monitor PeopleSoft Enterprise Process Scheduler
(Process Scheduler). You can also use the agent to take basic actions with the Process Scheduler.

IBM® Tivoli® Monitoring is the base software for the PeopleSoft Enterprise Process Scheduler agent. The
PeopleSoft Enterprise Process Scheduler agent monitors the availability, health, and performance of key
PeopleSoft Application Domain resources: application server, Tuxedo, Process Schedulers, Analytic
Servers, and Domain and Tuxedo logs.

IBM Tivoli Monitoring

IBM Tivoli Monitoring provides a way to monitor the availability and performance of all the systems in
your enterprise from one or several designated workstations. It also provides useful historical data that
you can use to track trends and to troubleshoot system problems.

You can use IBM Tivoli Monitoring to achieve the following tasks:

* Monitor for alerts on the systems that you are managing by using predefined situations or custom
situations.

* Establish your own performance thresholds.
¢ Trace the causes leading to an alert.
* Gather comprehensive data about system conditions.

* Use policies to take actions, schedule work, and automate manual tasks.

The Tivoli Enterprise Portal is the interface for IBM Tivoli Monitoring products. You can use the
consolidated view of your environment as seen in the Tivoli Enterprise Portal to monitor and resolve
performance issues throughout the enterprise.

See the IBM Tivoli Monitoring publications listed in|“Prerequisite publications” on page 17] for complete
information about IBM Tivoli Monitoring and the Tivoli Enterprise Portal.

Functions of the monitoring agent

Monitors the availability, health, and performance of key PeopleSoft Process Scheduler resources:
Batch Processes, Tuxedo, and Scheduler and Tuxedo logs.

New in this release

For version 7.1.1 of the PeopleSoft Enterprise Process Scheduler agent, the following enhancements were
made since version 6.2, including the fix packs:

¢ Changes related to system requirements. See the information about system requirements in
[product compatibility reports| (http:/ /publib.boulder.ibm.com/infocenter/prodguid/v1r0/clarity /
index.html).

* Updated kp9.baroc file to support event mapping changes

* Added support for the IBM Prerequisite Scanner, which is a stand-alone prerequisite checking tool that
analyzes system environments before the installation or upgrade of a Tivoli product or IBM solution.

* New bundled agent diagnostics script that provides detailed PeopleSoft installation functionality and
configuration data for level three support.
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Important: The script records the PeopleSoft installation, configuration, user permissions, and system
layout. Also, the script tests and reports on the critical data collection procedure that the PeopleSoft
agent completes to monitor the PeopleSoft environment.

Components of the IBM Tivoli Monitoring environment

After you install and set up the PeopleSoft Enterprise Process Scheduler agent, you have an environment
that contains the client, server, and monitoring agent implementation for Tivoli Monitoring.

This Tivoli Monitoring environment contains the following components:

Tivoli Enterprise Portal client
The portal has a user interface based on Java' for viewing and monitoring your enterprise.

Tivoli Enterprise Portal Server
The portal server is placed between the client and the Tivoli Enterprise Monitoring Server and
enables retrieval, manipulation, and analysis of data from the monitoring agents. The Tivoli
Enterprise Portal Server is the central repository for all user data.

Tivoli Enterprise Monitoring Server
The monitoring server acts as a collection and control point for alerts received from the
monitoring agents, and collects their performance and availability data. The Tivoli Enterprise
Monitoring Server is also a repository for historical data.

Tivoli Enterprise Monitoring Agent, PeopleSoft Enterprise Process Scheduler agent
This monitoring agent collects data and distributes the data to the Tivoli Enterprise Monitoring
Server, Tivoli Enterprise Portal Server, Tivoli Enterprise Portal, Tivoli Data Warehouse, and Tivoli
Integrated Portal.

Multiple copies of this agent can run on the same system.

IBM Tivoli Netcool/OMNIbus
Tivoli Netcool/OMNIbus is an optional component and the recommended event management
component. The Netcool/OMNIbus software is a service level management (SLM) system that
delivers real-time, centralized monitoring of complex networks and IT domain events. Event
information is tracked in a high-performance, in-memory database and presented to specific users
through individually configurable filters and views. The software includes automation functions
that you can use to perform intelligent processing on managed events. You can use this software
to forward events for Tivoli Monitoring situations to Tivoli Netcool/OMNIbus.

IBM Tivoli Enterprise Console®
The Tivoli Enterprise Console is an optional component that acts as a central collection point for
events from various sources, including events from other Tivoli software applications, Tivoli
partner applications, custom applications, network management platforms, and relational
database systems. You can view these events through the Tivoli Enterprise Portal (by using the
event viewer), and you can forward events from Tivoli Monitoring situations to the Tivoli
Enterprise Console component. If you do not already use Tivoli Enterprise Console and need an
event management component, you can choose to use IBM Tivoli Netcool/OMNIbus.

IBM Tivoli Common Reporting
Tivoli Common Reporting is a separately installable feature available to users of Tivoli software
that provides a consistent approach to generating and customizing reports. Some individual
products provide reports that are designed for use with Tivoli Common Reporting and have a
consistent look and feel.

IBM Tivoli Application Dependency Discovery Manager (TADDM)
TADDM delivers automated discovery and configuration tracking capabilities to build application
maps that provide real-time visibility into application complexity.

IBM Tivoli Business Service Manager
The Tivoli Business Service Manager component delivers real-time information to help you
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respond to alerts effectively based on business requirements. Optionally, you can use this
component to meet service-level agreements (SLAs). Use the Tivoli Business Service Manager
tools to help build a service model that you can integrate with Tivoli Netcool/OMNIbus alerts or
optionally integrate with data from an SQL data source. Optional components provide access to
data from other IBM Tivoli applications such as Tivoli Monitoring and TADDM.

Agent Management Services

You can use IBM Tivoli Monitoring Agent Management Services to manage the PeopleSoft Enterprise
Process Scheduler agent.

Agent Management Services is available for the following IBM Tivoli Monitoring OS agents: Windows,
Linux, and UNIX. The services are designed to keep the PeopleSoft Enterprise Process Scheduler agent
available, and to provide information about the status of the product to the Tivoli Enterprise Portal. IBM
Tivoli Monitoring V6.2.2, Fix Pack 2 or later provides support for Agent Management Services. For more
information about Agent Management Services, see Agent Management Services in the IBM Tivoli
Monitoring Administrator’s Guide.

User interface options

Installation of the base IBM Tivoli Monitoring software and other integrated applications provides
various interfaces that you can use to work with your resources and data.

The following interfaces are available:

Tivoli Enterprise Portal user interface
You can run the Tivoli Enterprise Portal as a desktop application or a browser application. The
client interface is a graphical user interface (GUI) based on Java on a Windows or Linux
workstation. The browser application is automatically installed with the Tivoli Enterprise Portal
Server. The desktop application is installed by using the Tivoli Monitoring installation media or
with a Java Web Start application. To start the Tivoli Enterprise Portal browser client in your
Internet browser, enter the URL for a specific Tivoli Enterprise Portal browser client installed on
your web server.

Command-line interface
You can use Tivoli Monitoring commands to manage the Tivoli Monitoring components and their
configuration. You can also run commands at the Tivoli Enterprise Console event server or the
Tivoli Netcool/OMNIbus ObjectServer to configure event synchronization for enterprise
situations.

Manage Tivoli Enterprise Monitoring Services window
You can use the window for the Manage Tivoli Enterprise Monitoring Services utility to configure
the agent and start Tivoli services not designated to start automatically.

IBM Tivoli Netcool/OMNIbus event list
You can use the Netcool/OMNIbus event list to monitor and manage events. An event is created
when the Netcool/OMNIbus ObjectServer receives an event, alert, message, or data item. Each
event is made up of columns (or fields) of information that are displayed in a row in the
ObjectServer alerts.status table. The Tivoli Netcool/OMNIbus web GUI is also a web-based
application that processes network events from one or more data sources and presents the event
data in various graphical formats.

IBM Tivoli Enterprise Console
You can use the Tivoli Enterprise Console to help ensure the optimal availability of an IT service
for an organization. The Tivoli Enterprise Console is an event management application that
integrates system, network, database, and application management. If you do not already use
Tivoli Enterprise Console and need an event management component, you can choose to use
Tivoli Netcool/OMNIbus.
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IBM Tivoli Common Reporting
Use the Tivoli Common Reporting web user interface for specifying report parameters and other
report properties, generating formatted reports, scheduling reports, and viewing reports. This
user interface is based on the Dashboard Application Services Hub for Tivoli Common Reporting
3.1 and on Tivoli Integrated Portal for earlier versions.

IBM Tivoli Application Dependency Discovery Manager
The Discovery Management Console is the TADDM client user interface for managing
discoveries.

IBM Tivoli Business Service Manager
The Tivoli Business Service Manager console provides a graphical user interface that you can use
to logically link services and business requirements within the service model. The service model
provides an operator with a second-by-second view of how an enterprise is performing at any
moment in time or how the enterprise performed over a time period.

IBM Dashboard Application Services Hub
The Dashboard Application Services Hub provides an administrative console for applications that
use this framework. It is a web-based console that provides common task navigation for
products, aggregation of data from multiple products into a single view, and the passing of
messages between views from different products. This interface replaces the Tivoli Integrated
Portal component after version 2.2.

Tivoli Integrated Portal
Web-based products that are built on the Tivoli Integrated Portal framework share a common
user interface where you can launch applications and share information. After version 2.2, this
interface is replaced by the Dashboard Application Services Hub.

Data sources

Monitoring agents collect data from specific data sources.

The PeopleSoft Enterprise Process Scheduler agent collects data from the following sources:

Availability
Use the agent to monitor availability of the application and related components in the following
ways:
* Monitor the status of the processes.

Log files
The agent uses the file system to monitor application log files or other data files to gather
metrics.
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Chapter 2. Agent installation and configuration

Agent installation and configuration requires the use of the IBM Tivoli Monitoring Installation and Setup
Guide and agent-specific installation and configuration information.

To install and configure the PeopleSoft Enterprise Process Scheduler agent, use the Installing monitoring
agents procedures in the IBM Tivoli Monitoring Installation and Setup Guide along with the agent-specific
installation and configuration information.

If you are installing silently by using a response file, see “Performing a silent installation of IBM Tivoli
Monitoring” in the IBM Tivoli Monitoring Installation and Setup Guide.

With the self-describing agent capability, new or updated IBM Tivoli Monitoring agents using IBM Tivoli
Monitoring V6.2.3 or later can become operational after installation without having to perform additional
product support installation steps. To take advantage of this capability, see “Enabling self-describing
agent capability at the hub monitoring server” in the IBM Tivoli Monitoring Installation and Setup Guide.
Also, see “Self-describing monitoring agents” in the IBM Tivoli Monitoring Administrator’s Guide.

Requirements

Before installing and configuring the agent, make sure your environment meets the requirements for the
IBM Tivoli Composite Application Manager Agent for PeopleSoft Enterprise Process Scheduler.

For information about requirements, see the Prerequisites topic for the agent in the [[BM Tivoli Composite]
[Application Manager for Applications Information Center| (http:/ /publib.boulder.ibm.com/infocenter /
tivihelp/...).

For the most up-to-date information about system requirements, see the [Software product compatibility]
(http:/ /publib.boulder.ibm.com/infocenter /prodguid /v1r0/clarity /index.html). Search for the
ITCAM for Applications product.

Language pack installation

The steps for installing language packs depend on which operating system and mode of installation you
are using.

To install a language pack for the agent support files on the Tivoli Enterprise Monitoring Server, the
Tivoli Enterprise Monitoring Agent, and the Tivoli Enterprise Portal Server, make sure that you installed
the product in the English language. Then use the steps for the operating system or mode of installation
you are using:

“Installing language packs on Windows systems’]

* [“Installing language packs on UNIX or Linux systems” on page 6|

« [“Silent installation of language packs on Windows, UNIX, or Linux systems” on page 7|

Installing language packs on Windows systems

You can install the language packs on a Windows system.
Before you begin

First, make sure that you installed the product in the English language.
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Procedure

ok wnp =

10.

On the language pack CD, double-click the Tpinstaller.bat file to start the installation program.
Select the language of the installer and click OK.

In the Introduction panel, click Next

Click Add/Update and click Next.

Select the folder where the National Language Support package (NLSPackage) files are located.
Typically, the NLSPackage files are located in the nlspackage folder where the installer executable
file is located.

Select the language support for the agent of your choice and click Next. To make multiple selections,
press Ctrl and select the language that you want.

Select the languages that you want to install and click Next.
Examine the installation summary page and click Next to begin installation.
After installation completes, click Finish to exit the installer.

Restart the Tivoli Enterprise Portal, Tivoli Enterprise Portal Server, and Eclipse Help Server if any of
these components are installed.

Installing language packs on UNIX or Linux systems

You can install the language packs on a UNIX or Linux system.

Before you begin

First, make sure that you installed the product in the English language.

Procedure

1. Enter the mkdir command to create a temporary directory on the computer, for example, mkdir
dir_name. Make sure that the full path of the directory does not contain any spaces.

2. Mount the language pack CD to the temporary directory that you created.

3. Enter the following command to start the installation program:
cd dir_name 1pinstaller.sh -c install_dir
Where: install_dir is where you installed IBM Tivoli Monitoring. Typically, the directory name is
/opt/IBM/ITM for UNIX and Linux systems.

4. Select the language of the installer and click OK.

5. In the Introduction panel, click Next.

6. Click Add/Update and click Next.

7. Select the folder where the National Language Support package (NLSPackage) files are located.
Typically, the NLSPackage files are located in the n1spackage folder where the installer executable file
is located.

8. Select the language support for the agent of your choice and click Next. To make multiple selections,
press Ctrl and select the language that you want.

9. Select the languages that you want to install and click Next.

10. Examine the installation summary page and click Next to begin installation.

11, After installation completes, click Finish to exit the installer.

12. Restart the Tivoli Enterprise Portal, Tivoli Enterprise Portal Server, and Eclipse Help Server if any of
these components are installed.
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Silent installation of language packs on Windows, UNIX, or Linux
systems
You can use the silent-mode installation method to install the language packs. In silent mode, the

installation process obtains the installation settings from a predefined response file. It does not prompt
you for any information.

Before you begin
First, make sure that you installed the product in the English language.

Procedure

1. Copy and paste the ITM_Agent_LP_silent.rsp response file template as shown in
ﬁ

2. Change the following parameter settings:

NLS_PACKAGE_FOLDER
Folder where the National Language Support package (NLSPackage) files are located.
Typically, the NLSPackage files are located in the nlspackage folder, for example:
NLS_PACKAGE_FOLDER = //tmp//LP//nlspackage.

PROD_SELECTION_PKG
Name of the language pack to install. Several product components can be included in one
language package. You might want to install only some of the available components in a
language pack.

BASE_AGENT_FOUND_PKG_LIST
Agent for which you are installing language support. This value is usually the same as
PROD_SELECTION_PKG.

LANG_SELECTION_LIST
Language you want to install.

3. Enter the command to install the language pack with a response file (silent installation):
* For Windows systems:
Tpinstaller.bat -f path_to_response file
¢ For UNIX or Linux systems:
Tpinstaller.sh -c candle_home -f path_to response file

where candle_home is the IBM Tivoli Monitoring base directory.

Response file example

# IBM Tivoli Monitoring Agent Language Pack Silent Installation Operation
#

#This is a sample response file for silent installation mode for the IBM Tivoli
#Monitoring Common Language Pack Installer.

#.

#This file uses the IBM Tivoli Monitoring Common Agent Language Pack with the
#install package as an example.

#Note:

#This response file is for the INSTALLATION of Tanguage packs only.

#This file does not support UNINSTALLATION of Tanguage packs in silent mode.

#To successfully complete a silent installation of the the example of Common Agent
#localization pack, complete the following steps:

#

#1.Copy ITM_Agent_LP_silent.rsp to the directory where lpinstaller.bat or
#1pinstaller.sh is located (IBM Tivoli Monitoring Agent Language Pack build
#location).
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#

#2.Modify the response file so that it is customized correctly and completely for
#your site.

# Complete all of the following steps in the response file.

#

#3.After customizing the response file, invoke the silent installation using the
#following command:

#For Windows:

# Ipinstaller.bat -f <path_to_response_file>

#For UNIX and Linux:

# Ipinstaller.sh -c <candle_home> -f <path_to_response_file>
#Note:<candle_home> is the IBM Tivoli Monitoring base directory.

#NLS Package Folder, where the NLS Packages exist.

#For Windows:

# Use the backslash-backslash(\\) as a file separator (for example,
#C:\\zosgmv\\LCD7-3583-01\\n1spackage).

#For UNIX and Linux:

# Use the slash-slash (//) as a file separator (for example,
#//installtivoli//1psilenttest//nlspackage).

#NLS_PACKAGE_FOLDER=C:\\zosgmv\\LCD7-3583-01\\nTspackage
NLS_PACKAGE_FOLDER=//tmp//LP//nl1spackage

#List the packages to process; both variables are required.
#Each variable requires that full paths are specified.
#Separate multiple entries with a semicolon (;).

#For Windows:

# Use the backslash-backslash(\\) as a file separator.

#For Unix and Linux:

# Use the slash-slash (//) as a file separator.

e e e

#PROD_SELECTION_PKG=C:\\zosgmv\\LCD7-3583-01\\nTspackage\\KIP_NLS.n1spkg
#BASE_AGENT_FOUND_PKG_LIST=C:\\zosgmv\\LCD7-3583-01\\nTspackage\\KIP_NLS.nTspkg
PROD_SELECTION_PKG=//tmp//LP//n1spackage//kex_nls.nlspkg;//tmp//LP//n1spackage//
kog_nls.nTspkg
BASE_AGENT_FOUND_PKG_LIST=//tmp//LP//n1spackage//kex_nls.nlspkg;//
tmp//LP//n1spackage//koq_nls.nlspkg

#List the languages to process.
#Separate multiple entries with semicolons.

LANG_SELECTION_LIST=pt BR;fr;de;it;jasko;zh_CN;es;zh TW

Agent-specific installation and configuration

In addition to the installation and configuration information in the IBM Tivoli Monitoring Installation and
Setup Guide, use this agent-specific installation and configuration information to install the PeopleSoft
Enterprise Process Scheduler agent.

The following information relates to installing and configuring the PeopleSoft Enterprise Process
Scheduler agent:

* [Steps for installing the agents|

¢ [Installation accouth'

+ [“Linux and UNIX setup” on page 9
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* [Loading and unloading the data collection PeopleSoft project|

* [Configuring the agent with a PeopleSoft user name and password|

« [Configuring attribute data caching]|

* [Configuration values|

+ [Remote installation and configuration|

Installing the PeopleSoft Enterprise Process Scheduler agent

To install and configure the PeopleSoft Enterprise Process Scheduler agent, use the procedures in the IBM
Tivoli Monitoring Installation and Setup Guide along with the information in this chapter.

Procedure
1. Complete one of the following steps depending on your operating system:

* On Linux and UNIX systems, install the PeopleSoft monitoring agent to run under the same
operating system account as PeopleSoft.

* On Windows systems, install and configure the PeopleSoft monitoring agent to run under the same
operating system account as PeopleSoft.

See [“Installation account”] for additional information.

2. For Linux and UNIX operating systems, set up the operating system login environment:
a. Ensure that a PeopleSoft environment is set up.

See [“Linux and UNIX setup”| for additional information about setting up the login environment.

3. Use the PeopleSoft Application Designer client to load the provided ITM_Query PSAE program into
the PeopleSoft environment. Choose one of the following three options to configure a PeopleSoft User
ID for the monitoring agent to use to monitor the system:

¢ Use an existing user.
* Manually create the user with the necessary permissions.
* Load the example ITM_PS user, role, and permission list.

See [‘Configuring the agent with a PeopleSoft user name and password” on page 12| for information
about the necessary permissions. Also, see|“Loading the IBM Tivoli Monitoring data collection|
[PeopleSoft project” on page 10| for additional information.

Installation account

The PeopleSoft application server uses the Tuxedo product to perform transaction management,
messaging, and administration. Because of the strict file access and interprocess communications
permissions enforced by the Tuxedo product, you must run the PeopleSoft Enterprise Process Scheduler
agent and the PeopleSoft Enterprise Process Scheduler agent with the same login account used to install
the PeopleSoft system.

On Linux and UNIX systems, the PeopleSoft processes run with credentials specifically created for use
with the PeopleSoft system by a PeopleSoft administrator. The PeopleSoft Enterprise Process Scheduler
agent must be installed and run under that same account. Running the PeopleSoft Enterprise Process
Scheduler agent under the root user account when PeopleSoft is running under another account is not
supported.

On Windows systems, the PeopleSoft Enterprise Process Scheduler agent must run under the same

account as the PeopleSoft Process Scheduler. You can use Windows Task Manager to determine the
account for the PeopleSoft Process Scheduler processes, such as psprcsrv.exe.

Linux and UNIX setup

Set up the operating system login environment for Linux and UNIX systems.
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Login environment on UNIX systems

PeopleTools is the proprietary software development environment that was created by the PeopleSoft
Corporation. The PeopleSoft monitoring agents require an appropriate PeopleTools environment to run in.
That is, the login profile for the PeopleSoft user account is correctly established for the PeopleSoft and
database environment variables. For example, for a PeopleSoft Domain running against an Oracle
database, the login environment has both the Oracle database libraries and PeopleSoft libraries in PATH,
LD_LIBRARY_PATH, and LIBPATH. Setting up this environment typically includes sourcing the
PeopleSoft psconfig.sh script.

To test whether the user account you are using to install the PeopleSoft monitoring agent has the
required permissions and environment setup, from the command line type the following commands:

cd $PS_HOME/appserv
./psadmin

If the environment was set up correctly, the PSADMIN tool is displayed on the screen and results in the
following output:

PSADMIN -- Tools Release: 8.48
Copyright (c) 1988-2005 PeopleSoft, Inc. A1l Rights Reserved.

1) Application Server
2) Process Scheduler
3) Search Server

q) Quit

Command to execute (1-3, q):

UNIX shells

The PeopleSoft Enterprise Application Domain agent and PeopleSoft Enterprise Process Scheduler agent
can be run with operating system user accounts using the sh, bash, and ksh shells. The csh and tcsh
shells are not supported.

Loading and unloading the IBM Tivoli Monitoring data collection
PeopleSoft project
The final installation step is to load the IBM Tivoli Monitoring data collection PeopleSoft project.

See |“Loading the IBM Tivoli Monitoring data collection PeopleSoft project”| for information about how to
load this project. If you need to remove the IBM Tivoli Monitoring data collection PeopleSoft project, use
the information in [“Removal of PeopleSoft agent components from the PeopleSoft database” on page 11

When you upgrade to a new version of the IBM Tivoli Monitoring or PeopleSoft Enterprise Process
Scheduler agent, you must remove the old version of the IBM Tivoli Monitoring data collection
PeopleSoft project and install the new version.

Loading the IBM Tivoli Monitoring data collection PeopleSoft project
The PeopleSoft Enterprise Application Domain agent and PeopleSoft Enterprise Process Scheduler agent
gather dynamic data from the PeopleSoft system through a PeopleSoft application engine program.

The ITM_QUERY PeopleSoft project consists of a PeopleSoft Application Engine (PSAE) program, a
record, and several SQL objects. Each object is prefixed with ITM_. Because of the prefix, a naming
collision between the new objects and existing objects is unlikely to occur. Nevertheless, you should run a
compare and report step in Application Designer before you load the ITM_QUERY project.
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A PeopleSoft administrator must extract and then load the ITM_QUERY project into the PeopleSoft
database. PeopleTools 8.48, 8.49, 8.50, 8.51, 8.52, and 8.53 versions of the ITM_QUERY project are
included in the distribution in the following locations:

* PeopleTools 8.48: ITM Application Engine/8.48/ITM_QUERY_8.48.zip
* PeopleTools 8.49: ITM Application Engine/8.49/ITM_QUERY_8.49.zip
* PeopleTools 8.50: ITM Application Engine/8.50/ITM_QUERY_8.50.zip
» PeopleTools 8.51: ITM Application Engine/8.51/ITM_QUERY_8.51.zip
* PeopleTools 8.52: ITM Application Engine/8.52/ITM_QUERY_8.52.zip
* PeopleTools 8.53: ITM Application Engine/8.53/ITM_QUERY_8.53.zip

Removal of PeopleSoft agent components from the PeopleSoft database

When you uninstall a PeopleSoft monitoring agent, you must complete additional steps to completely
remove the PeopleSoft monitoring agent components that were loaded into the database that was used
during the installation process.

Important: These steps only need to be performed once, regardless of whether the PeopleSoft Enterprise
Process Scheduler agent, the PeopleSoft Enterprise Process Scheduler agent, or both agents were installed.

Removing the ITM_QUERY_PROJ PeopleSoft project manually:

To delete the ITM_QUERY project from the PeopleSoft system, remove the following objects:
* Project: ITM_QUERY_PRO]J
* App Engine Program: ITM_QUERY
* Record: ITM_QUERY_AET
* SQL:
- ITM_ANALYTIC_SERVERS
— ITM_DISTRIBUTION_STATUS_COUNTS
- ITM_INSTALLED_LANGUAGES
— ITM_PMN_SRVRLIST
- ITM_PRCS_REQUEST_LOAD_RANK_24H
- ITM_PRCS_REQUEST_LOAD_RANK_30D
- ITM_PRCS_REQUEST_LOAD_RANK_7D
— ITM_PROCESS_CATEGORY_ACTIVITY
- ITM_PROCESS_REQUEST_TABLE
- ITM_PROCESS_TYPE_ACTIVITY
- ITM_PSSTATUS
- ITM_PURGE_OPTIONS
— ITM_PURGE_RUN_STATUS_OPTIONS
— ITM_RUN_STATUS_COUNTS
- ITM_VERSION

Removing the ITM_QUERY_PROJ PeopleSoft project by script:

The REMOVE_ITM_QUERY application designer project is used to remove the entries in the database
that were added by the ITM_QUERY project.

About this task

The REMOVE_ITM_QUERY project and delete data mover scripts are located in the distribution in the
following locations:
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PeopleTools 8.48: ITM Application Engine/8.48/I1TM_QUERY_8.48.zip
PeopleTools 8.49: ITM Application Engine/8.49/ITM_QUERY_8.49.zip
PeopleTools 8.50: ITM Application Engine/8.50/ITM_QUERY_8.50.zip
PeopleTools 8.51: ITM Application Engine/8.51/ITM_QUERY_8.51.zip
PeopleTools 8.52: ITM Application Engine/8.52/ITM_QUERY_8.52.zip
PeopleTools 8.53: ITM Application Engine/8.53/ITM_QUERY_8.53.zip

Procedure

1.
2.
3.

© N o oA

Start the application designer with a valid PeopleSoft ID, for example, PS.
From the Tools menu, select Copy Project > From File.

Navigate to the folder of your Peopletools version, 8.48, 8.49, 8.50, 8.51, 8.52, or 8.53, and select the
project in the REMOVE_ITM_QUERY projects.

Click Copy on the Copy from File window.

On the File menu, select Delete.

Click Delete in the Delete Definition window. All available projects are displayed.
Select ITM_QUERY_PROYJ and click Delete, then confirm the deletion.

Select REMOVE_ITM_QUERY and click Delete, then confirm the deletion.

Configuring the agent with a PeopleSoft user name and password

The monitoring agent must be configured with a valid PeopleSoft user name (PSAE_USER) and password
(PSAE_PASSWORD) to run the ITM_QUERY application through psae.

About this task

Check with a PeopleSoft administrator to determine the appropriate PeopleSoft account to use for the
monitoring agents. The account can come from the following places:

An existing system maintenance account. Many PeopleSoft systems already have an account for
performing maintenance operations.

A new account set up by the PeopleSoft administrator. The PeopleSoft user requires a role within a
permission list with process group permissions to the TLSALL process group.

A sample user named ITM_PS, a role named ITM_PSRL, and a permissions list named ITM_PSPL are
included on the agent installation media. These objects can be loaded by using a second PeopleSoft
project and data mover script. The ITM_PS user has one role, which is ITM_PSPL. The ITM_PSPL role has
one permission list, which is ITM_PSRL. The ITM_PSPL role has permission to use only the TLSALL
process group. With these permissions, the ITM_PS user has access to run only the application engine
from the command line. The ITM_PS user has no permission to run the application engine through the
web interface; use the application designer, or run the data mover.

Complete the following steps to load the ITM_PS user:

Procedure

1.
2.

12

Load the ITM_PS user project.

Load the ITM_PS user data mover script. The ITM_PS project and data mover scripts are located in the
distribution in the following locations:

* PeopleTools 8.48: ITM PeopleSoft User/8.48/ITM_PS_USER_8.48.zip
* PeopleTools 8.49: ITM PeopleSoft User/8.49/ITM_PS_USER_8.49.zip
* PeopleTools 8.50: ITM PeopleSoft User/8.50/ITM_PS_USER_8.50.zip
* PeopleTools 8.51: ITM PeopleSoft User/8.51/ITM_PS_USER 8.51.zip
* PeopleTools 8.52: ITM PeopleSoft User/8.52/ITM_PS_USER_8.52.zip
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* PeopleTools 8.53: ITM PeopleSoft User/8.53/ITM_PS_USER_8.53.zip

The PeopleSoft project is in the ITM_PS subdirectory. The import_itm_ps.dms data mover script is in

the DMS subdirectory. The second line of the import_itm_ps.dms script references the itm_ps.dat file.
You might need to change this file reference to an absolute path to the itm_ps.dat file if the data

mover is not running from the same working directory. You must import both the project and data

mover scripts because each script loads only a portion of the ITM_PS, ITM_PSRL and ITM_PSPL
objects and does not work independently.

The default ITM_PS user password is password. Change the ITM_PS user password to something more

secure.

Change the ITM_PS user Symbolic ID. The user's Symbolic ID (in the Logon Information section of the

user profile) must be set to the name of the PeopleSoft application being monitored. Until this ID is

set appropriately, the ITM_PS user might not be able to run the ITM_QUERY application.

Removing the ITM_PS user

The purpose of the REMOVE_ITM_PS project and delete_itm_user.dms datamover script is to remove

the ITM_PS user role that was installed with this, or a previous, version of the PeopleSoft monitoring
agent. The following steps completely remove the ITM_PS user role from the system.

About this task

The REMOVE_ITM_PS project and delete data mover scripts are located in the distribution in the

following locations:
PeopleTools 8.48:
PeopleTools 8.49:
PeopleTools 8.50:
PeopleTools 8.51:
PeopleTools 8.52:
PeopleTools 8.53:

ITM PeopleSoft User/8.48/ITM_PS _8.48.
ITM PeopleSoft User/8.49/ITM_PS _8.49.
ITM PeopleSoft User/8.50/ITM_PS _8.50.
ITM PeopleSoft User/8.51/ITM_PS _8.51.
ITM PeopleSoft User/8.52/ITM_PS _8.52.
ITM PeopleSoft User/8.52/ITM_PS _8.53.

zip
zip
zip
zip
zip
zip

Complete the following steps within the PeopleSoft Application Designer:

Procedure
Start the application designer with a valid Peoplesoft superuser ID, for example, PS.

© N o o~ Db~

From the Tools menu, select Copy Project > From File.
Select the REMOVE_ITM_PS project for your PeopleTools version, 8.48, 8.49, 8.50, 8.51, 8.52, or 8.53.
Click Copy on the Copy from File window.

On the File menu, select Delete.

Click Delete in the Delete Definition window. All available projects are displayed.
Select ITM_PS and click Delete, then confirm the deletion.
Select REMOVE_ITM_PS and click Delete, then confirm the deletion.

To run the remove script:
About this task

Using the Peoplesoft Datamover utility, complete the following steps to run the remove script:

Procedure

1.

Copy the delete_itm_ps.dms file from the installation media to a working directory; for example,

C:\dmsdelete.

2. Start the Datamover utility and log in with a valid PeopleSoft superuser ID, for example, PS.

Chapter 2. Agent installation and configuration
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3. Open the delete_itm_ps.dms file in the Datamover utility. Select File > Open >C:\dmsdelete\
delete_itm ps.dms.

4. Append the path to your working directory following Set 1og and Set output.
5. Click the green light icon to run the script.

Configuring attribute data caching

The majority of attributes gathered by the PeopleSoft Enterprise Process Scheduler agent are not provided
in real time. Instead, attributes are gathered and cached until another gathering cycle commences.

Use the DATA_COLLECTION_INTERVAL configuration option to adjust the frequency at which
attributes are gathered. DATA_COLLECTION_INTERVAL specifies the number of minutes between
attribute collection cycles. The default frequency is 10 minutes and the minimum frequency is 1 minute.

The data collected by the availability and log file monitoring components of the monitoring agents is
collected in real time. All other attributes are cached.

Configuration values

For both local and remote configuration, you provide the configuration values for the agent to operate.

When you are configuring an agent, a panel is displayed so you can enter each value. When a default
value exists, this value is pre-entered into the field. If a field represents a password, two entry fields are
displayed. You must enter the same value in each field. The values that you type are not displayed to
help maintain the security of these values.

The configuration for this agent is organized into the following groups:

Basic (PEOPLESOFT_SCHEDULER)
Basic configuration values

The configuration elements defined in this group are always present in the agent's configuration.
This group defines information that applies to the entire agent.

Agent Log Level (JAVA_TRACE_LEVEL)
The log level of the PeopleSoft Scheduler agent.
The type is one of the following values: "Off", "Error", "Warning", "Information”, "Debug".
This value is required.
Default value: WARN

PeopleSoft application engine (PSAE) password (KP9_PSAE_PASSWORD)
The PeopleSoft application engine (PSAE) password for the PSAE user account that is
used by the ITM agent.

The type is password.
This value is required.
Default value: None

PeopleSoft application engine (PSAE) user name (KP9_PSAE_USER)
The PeopleSoft application engine (PSAE) user name that is configured to use with the
PeopleSoft agent.

The type is string.
This value is required.

Default value: None
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Fully qualified path for the Process Scheduler psprcs.cfg file (KP9_PS_SERVER_CFG)
The fully qualified path for the Process Scheduler configuration file (psprcs.cfg).

The type is string.
This value is required.
Default value: None

PeopleSoft Home (PS_HOME)
The path to the PeopleSoft home directory.

The type is string.
This value is required.

Default value: None

Remote installation and configuration

You can install the monitoring agent remotely from the Tivoli Enterprise Portal or from the command
line.

When vou install the agent remotely, you must provide the configuration values for the agent to operate.
See |[“Configuration values” on page 14/

To install from the portal, see the IBM Tivoli Monitoring Installation and Setup Guide.

To remotely install or configure an agent through the Tivoli Enterprise Portal, application support for that
agent must be installed (Tivoli Enterprise Monitoring Server, Tivoli Enterprise Portal Server, and Tivoli
Enterprise Portal). Also, the agent bundle must be installed in the Remote Deploy Depot.

For information about displaying the configuration options that are available to use with the
configureSystem or addSystem commands see “tacmd describeSystemType” in the IBM Tivoli Monitoring
Command Reference.

If you are using the command line, the following command is an example of remote installation and
configuration for Windows operating systems:

tacmd addSystem -t P9 -n Primary:sample.node.name:NT
-p PEOPLESOFT_SCHEDULER.JAVA_TRACE_LEVEL=value
PEOPLESOFT_SCHEDULER.KP9_PSAE_PASSWORD=value
PEOPLESOFT_SCHEDULER.KP9_PSAE_USER=value
PEOPLESOFT_SCHEDULER.KP9_PS_SERVER CFG=value
PEOPLESOFT_SCHEDULER.PS_HOME=value

INSTANCE="instI"
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Appendix. ITCAM for Applications documentation library

Various publications are relevant to the use of ITCAM for Applications.

For information about how to access and use the publications, see [Using the publications|
(http:/ /pic.dhe.ibm.com/infocenter/tivihelp /v61rl/topic/com.ibm.itm.doc_6.3/common/
using_publications.htm).

To find publications from the previous version of a product, click Previous versions under the name of
the product in the Contents pane.

Documentation for this product is in the ITCAM for Applications Information Center]
(http:/ /publib.boulder.ibm.com/infocenter/tivihelp /v24r1/topic/com.ibm.itcama.doc_7.2.1/
welcome_apps721.html):

* Quick Start Guide
* Offering Guide

¢ Download instructions

¢ Links to Prerequisites

* Installation and Configuration Guide for each agent
* Link to Reference information for each agent

* Link to Troubleshooting Guide for each agent

Prerequisite publications

To use the information about the agents effectively, you must have some prerequisite knowledge.

See the following information at the [[BM Tivoli Monitoring Information Centet] (http://pic.dhe.ibm.com/
infocenter/tivihelp /v61rl/index.jsp) to gain prerequisite knowledge:

* IBM Tivoli Monitoring Administrator’'s Guide
 IBM Tivoli Monitoring Installation and Setup Guide
* IBM Tivoli Monitoring High Availability Guide for Distributed Systems

 IBM Tivoli Monitoring: Installation and Configuration Guides for the following agents: Operating
System agents and Warehouse agents

 IBM Tivoli Monitoring: User's Guides for the following agents: Agentless OS monitors, Log File agent,
System p agents, Systems Director base agent

* IBM Tivoli Monitoring Agent Builder User’s Guide
 IBM Tivoli Monitoring Command Reference

* IBM Tivoli Monitoring: Messages

* IBM Tivoli Monitoring Troubleshooting Guide

+ IBM Tivoli Monitoring: References for the following agents: Operating System agents and Warehouse
agents

* IBM Tivoli Monitoring: Troubleshooting Guides for the following agents: Operating System agents and
Warehouse agents

* Tivoli Enterprise Portal User’s Guide

Related publications

The publications in related information centers provide useful information.
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See the following information centers, which you can find by accessing [Tivoli Documentation Central|
(https:/ /www.ibm.com/developerworks/community /wikis /home?lang=en#! /wiki/Tivoli
%20Documentation%20Central):

 Tivoli Monitoring

* Tivoli Application Dependency Discovery Manager
¢ Tivoli Business Service Manager

* Tivoli Common Reporting

* Tivoli Enterprise Console

¢ Tivoli Netcool/OMNIbus

Tivoli Monitoring Community on Service Management Connect

Service Management Connect (SMC) is a repository of technical information that is organized by
communities.

Access Service Management Connect at [https: / /www.ibm.com/developerworks /servicemanagement]

For information about Tivoli products, see the [Application Performance Management communityl
(http:/ /www.ibm.com/developerworks/servicemanagement/apm/index.html).

Connect, learn, and share with Service Management professionals. Get access to developers and product
support technical experts who provide their perspectives and expertise. You can use SMC for these
purposes:

* Become involved with transparent development, an ongoing, open engagement between other users
and IBM developers of Tivoli products. You can access early designs, sprint demonstrations, product
roadmaps, and prerelease code.

* Connect one-on-one with the experts to collaborate and network about Tivoli and the (enter your
community name here) community.

* Read blogs to benefit from the expertise and experience of others.
* Use wikis and forums to collaborate with the broader user community.

Other sources of documentation

You can obtain additional technical documentation about monitoring products from other sources.

See the following sources of technical documentation about monitoring products:

* [IBM Integrated Service Management Library| (http://www.ibm.com/software /brandcatalog/
ismlibrary/) is an online catalog that contains integration documentation as well as other
downloadable product extensions.

» [[BM Redbook publications| (http:/ /www.redbooks.ibm.com/) include Redbooks® publications,
Redpapers, and Redbooks technotes that provide information about products from platform and
solution perspectives.

. (http:/ /www.ibm.com/support/entry/portal/software), which are found through the IBM
Software Support website, provide the latest information about known product limitations and
workarounds.
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Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer the
products, services, or features discussed in this document in other countries. Consult your local IBM
representative for information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product, program, or service that
does not infringe any IBM intellectual property right may be used instead. However, it is the user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not give you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive

Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS”
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement might not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of

the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation

274A /101

11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurement may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without
notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. You may copy, modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application programs conforming
to IBM'’s application programming interfaces.
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Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:

© IBM 2009. Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp.
2009. All rights reserved.

If you are viewing this information in softcopy form, the photographs and color illustrations might not be
displayed.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the web at
[Copyright and trademark information| (www.ibm.com/legal /copytrade.shtml).

Intel, Intel logo, and Intel Xeon, are trademarks or registered trademarks of Intel Corporation or its
subsidiaries in the United States and other countries.

&

—
il
)

Java
[MPATIBLE

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.
Windows is a trademark of Microsoft Corporation in the United States, other countries, or both.
UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, or service names may be trademarks or service marks of others.

Privacy policy considerations

IBM Software products, including software as a service solutions, (“Software Offerings”) may use cookies
or other technologies to collect product usage information, to help improve the end user experience, to
tailor interactions with the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings can help enable you to
collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use session cookies that collect
each user’s user name for purposes of session management, authentication, and single sign-on
configuration. These cookies cannot be disabled.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, See
IBM’s Privacy Policy at |http:/ /www.ibm.com/privacy| and IBM’s Online Privacy Statement at
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